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Page 4 Index ......... . . 81 GL-10x0 Scan Operator’s Guide...

Page 5: Preface
Preface This Scan Operator’s Guide explains how to use the scanning functions of the TOSHIBA
Electronic Document Processing Systems. It also provides instructions for retrieving scanned
jobs, and for using the TopAccess web- based utility to set up and monitor scan jobs.

Page 6: Introduction
This Scan Operator’s Guide is not intended for digital copier service technicians or operators.
For information on using and maintaining the TOSHIBA digital copiers, refer to the Toshiba
Operator’s Guide for Copying Functions or contact your Toshiba authorized dealer for support.

Page 7 Light blue and Indicates text that is linked on Click the Install Software link at the
underlined a web page. This text is not bottom of the page. linked in the documentation.
GL-10x0 Scan Operator’s Guide...

Page 8 How this Guide is Organized Chapter 1, Features and Functions on page 1 introduces
the capability and components of the GL-Scan feature in the TOSHIBA Electronic Document
Processing System. Chapter 2, Scanning Overview on page 5 describes in outline how to set up
and use the GL-Scan feature.

Page 9: Supplemental References
In addition to the information in this guide, the following reference materials are available to
assist you in using and optimizing your controller: Toshiba Operator’s Guide for Copying
Functions This manual describes the digital copier functions: how to make copies, maintain the
copier, and troubleshoot mechanical and copying problems.

Page 10 All of the Electronic Document Processing System software and drivers come with
application-specific online help. Click or choose the Help options from the Help menu. For web-
based help in Contents and Index TopAccess, click the link. Help viii GL-10x0 Scan Operator’s
Guide...

Page 11: Features And Functions
Features and Functions The TOSHIBA Electronic Document Processing Systems provide network
scanning capability with a wide range of options but requires a minimum of time spent setting
up scan templates. This chapter describes the functionality of the GL-Scan feature and its
components.

Page 12: Features And Functions
E-mail or iFax jobs Software Components The GL-Scan feature uses several utilities that are
supplied with the TOSHIBA Electronic Document Processing System. This system consists of the
copier and the controller, a computer located inside the copier. Printer Drivers Printer drivers
enable devices, such as the controller, to receive information for printing from an application
program.

Page 13: System Components
Refer to the computer hardware manual to confirm these limitations. Scanning Modes There are
two modes available for scanning documents: Public Scan In this mode, you use scan templates
from the public template group. The administrator sets up and maintains the public templates.
Besides GL-10x0 Scan Operator’s Guide...

Page 14: System Requirements
general purpose templates which are available to all users connected to the controller, the
public group may include password-protected templates for specific purposes. Private Scan In
this mode, you use scan templates that are specific to a department (Accounting, Human
Resources, Research and Development, etc.) or to a project.

Page 15: Scanning Overview
Scanning Overview The GL-Scan feature of the TOSHIBA Electronic Document Processing
Systems enables you to scan documents and transfer the image file to various destinations. It
also enables you to send iFaxes. This chapter describes how to set up and use the GL-Scan
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feature.

Page 16: Setting Up
, you may find a template that Send to TopAccessComposer Send to FTP is very similar to what
you need either in the public group or in a private GL-10x0 Scan Operator’s Guide...

Page 17: Scanning A Document
In TopAccess, select the tab to open the Current Jobs page. Scan Scroll down the list to find your
job. Select the job and click Delete For more detail, see Monitoring Scan Jobs on page 55.
GL-10x0 Scan Operator’s Guide...

Page 18: Sending A Fax
Select the appropriate Send to iFax template. Check the list of recipients and make any
changes. Enter or modify the subject line and covering message if necessary. Press or S ! to
send the fax. START GL-10x0 Scan Operator’s Guide...

Page 19: Setup
You can use the TopAccess utility to create scan templates that contain all required scan and
distribution information. When these templates are downloaded to the copier, they facilitate
“one-touch scan and send tasks” from the copier control panel. GL-10x0 Scan Operator’s
Guide...

Page 20 The administrator sets up scan transfer agent properties in TopAccess under the
Administration tab, Scan Agents pages. For more information, refer to the Administrator’s Guide
or online help. GL-10x0 Scan Operator’s Guide...

Page 21 You can also create private templates for particular end users or groups. If you log
on to TopAccess as an end user, you can create and manage private groups and templates and
view basic public template information. GL-10x0 Scan Operator’s Guide...

Page 22: Using Public Templates
75 or the TopAccess online help for details. Click . You return to the Template Groups page and
details of the new group appear in the list of defined groups. Repeat this process to create more
groups. GL-10x0 Scan Operator’s Guide...

Page 23 Changing the Sort Order By default, the group list is sorted by Group Number in
ascending order (indicated by an up arrow in the column heading). To sort the list by Owner,
click the column heading. GL-10x0 Scan Operator’s Guide...

Page 24 12 for details. To change the group password, use the Edit procedure. See Editing
Private Group Information on page 13 for details. For template passwords, refer to Setting or
Changing Passwords for Private Templates on page 17. GL-10x0 Scan Operator’s Guide...

Page 25: Deleting Private Groups
The Templates page opens, listing all the templates defined for a selected group. By default,
this is the public group. The button is disabled until you select a private group (unless you are
logged in as an administrator). GL-10x0 Scan Operator’s Guide...

Page 26 Edit group. On the Templates page, select the group containing the template you
need to edit. If the Group Password popup opens, enter the group five-digit password and click
GL-10x0 Scan Operator’s Guide...

Page 27 Select the template(s) you want to delete. Click Delete If the Password popup opens,
enter the template five-digit password and click . A confirmation popup opens. Click to delete
the templates or to leave them unchanged. Cancel GL-10x0 Scan Operator’s Guide...

Page 28: Configuring Agent Settings
Enter the of the message (up to 128 characters). Subject checkbox is checked by default.
Include Scan details in e-mail body Uncheck this box to eliminate the scan details from the body
of the e- mail message. GL-10x0 Scan Operator’s Guide...
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Page 29 (no character limits). Accept the , which is File Format TIFF-S Note: The is
preconfigured by the administrator Maximum Message Size and cannot be modified. Select the
M ESSAGE RAGMENTATION GL-10x0 Scan Operator’s Guide...

Page 30 For example, Private\Toshibauser. Template Properties Page Select the , or Folder
Type Public Private Department Enter a if required depending on the Login User Name Password
folder type you chose. GL-10x0 Scan Operator’s Guide...

Page 31 If you check the option , select the number of Retry when FTP transfer fails retries
and the time interval between them. If necessary, change the for storing the scanned File Path
File Name file. Select the File Format GL-10x0 Scan Operator’s Guide...

Page 32 GL-10x0 Scan Operator’s Guide...

Page 33: Scanning Documents
Scanning Documents The scan function of the TOSHIBA Electronic Document Processing System
enables you to scan image data and send it to a variety of destinations. This chapter tells you
how to use the copier control panel for scanning documents and for changing scan settings.

Page 34: Introduction
If any of the limits are exceeded (over 180 MB on the e-STUDIO28-45, over 300 MB on the e-
STUDIO55-81, or over 1 GB total), an error is posted notifying you of a scan overflow and the
remainder of the job is cancelled. GL-10x0 Scan Operator’s Guide...

Page 35 Place an original on the glass face down with the bottom toward you and the left
side centered against the original scale. Original scale Printer with Automatic Document Feeder
Lifted You can scan up to 100 sheets (200 images). GL-10x0 Scan Operator’s Guide...

Page 36: Scanning Procedures
Scanning the Originals With the originals on the glass or in the ADF: Press on the control panel.
The Print menu opens. PRINTER/NETWORK Print Menu GL-10x0 Scan Operator’s Guide...

Page 37 Either use the numeric keys to enter the 3-digit number in the G ROUP . field, or
press the arrow key to scroll through the list and select the group number. To return to the Scan
menu, press C ANCEL GL-10x0 Scan Operator’s Guide...

Page 38: Selecting A Template
Input screen does not open, the template is not password protected. Enter the 5-digit password
using the numeric keys. The copier displays the numbers as asterisks. To clear or reenter the
password, press . To return to the Template Icon Selection CLEAR/STOP List, press CANCEL
GL-10x0 Scan Operator’s Guide...

Page 39 ADF in the scan settings summary area. If you are placing the originals on the glass,
the Scan Settings Summary screen displays Glass and the auto detected original size in the
scan settings summary area. GL-10x0 Scan Operator’s Guide...

Page 40: Adf Scanning
Parameter Setting screen. For further information, refer to Scan Parameter Settings on page 31.
To finish scanning, press F . When scanning is complete, the INISH Template Selection List
screen opens. The scanned image data is saved on the controller hard disk. GL-10x0 Scan
Operator’s Guide...

Page 41: Handling Paper Jams
, or Single Book Tablet The book and tablet double-sided modes are unavailable if you are
scanning from the glass. Select the desired rotation: No rotation Rotate through 90° Rotate
through , or 180° Rotate through 270° GL-10x0 Scan Operator’s Guide...

Page 42: Scan Agent Settings In The Control Panel
ADF or glass, and paper size. To change any of these settings, press to go to the Scan
Parameter SETTING Setting screens. For details, see Scan Parameter Settings on page 31.
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GL-10x0 Scan Operator’s Guide...

Page 43 Scan agent name: scan to TWAIN Folder: the name of the TWAIN data directory
folder Document: the name of the scanned document Scan Settings and FileShare Agent
Settings Summary FileShare Agent Settings Summary Screen GL-10x0 Scan Operator’s Guide...

Page 44 Add Message: displays any message added to the e-mail body. To modify the
recipient list, press the ellipsis [...] button adjacent to the list. The Address Edit screen opens.
For information on using this screen refer to Editing the List of Recipients on page 37. GL-10x0
Scan Operator’s Guide...

Page 45 256 characters. Press to save the changes. Scan Settings and FTP Agent Settings
Summary There are two screens for the Scan to FTP agent. Scan to FTP Settings Summary
Screen 1 GL-10x0 Scan Operator’s Guide...

Page 46: Working With The Address Book
OCUMENT and press Working with the Address Book You can alter the list of recipients defined
in a template, update e-mail addresses, display address book groups, and search for entries in
the address book. GL-10x0 Scan Operator’s Guide...

Page 47 A button. The Address Edit screen opens and the group members are added to the
recipient list. To return to the Address Edit screen without adding recipients, press the C ANCEL
button. GL-10x0 Scan Operator’s Guide...

Page 48: Searching The Address Book
LDAP server. Address Book Search Screen To search for recipients in a different Directory
Service (LDAP or TOSHIBA controller) press the down-arrow button next to the Directory name.
The Address Book and LDAP Server Selection screen opens, listing the address books and LDAP
servers defined in TopAccess.

Page 49 E-mail otherwise, sAMAccountName Name Operator Operator Contains Starts With,
Ends With, and Contains Sounds Like are unavailable if the address book is the controller Starts
With Ends With Sounds Like Text None Text to be matched GL-10x0 Scan Operator’s Guide...

Page 50 A . The Address Edit screen appears and the selected person is added to the
recipient list. To cancel the process or return to the previous screen, press C ANCEL GL-10x0
Scan Operator’s Guide...

Page 51: Scanning Destinations
Name – Template Number – Template Name> where: GLXXXXXXXXXXXX represents the MAC
address of the network interface card in the controller. Note: You can access saved Send to File
data regardless of whether the job is assigned a password. GL-10x0 Scan Operator’s Guide...

Page 52 Specify the image data format. Your only choice, however, is TIFF-S Send the image
data by dividing it in smaller blocks (fragment message). Your options are: , or No
fragmentation 256 KB 512 KB 1024 KB fragments. 2048 KB GL-10x0 Scan Operator’s Guide...

Page 53 Whether to retry if the FTP transfer fails and, if so, how many times and the number
of minutes between retries. The file format: , or Single Page TIFF (G4) Multi Page TIFF (G4)
Whether to overwrite an existing file of the same name in the destination folder. GL-10x0 Scan
Operator’s Guide...

Page 54 GL-10x0 Scan Operator’s Guide...

Page 55: Retrieving Documents
TWAIN, and summarizes the procedure for retrieving images from a file on the controller or file
server. It also provides reference-style descriptions of the TWAIN dialog boxes. For retrieving
images from TopAccessComposer, see the TopAccessComposer Operator’s Guide. GL-10x0 Scan
Operator’s Guide...
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Page 56: Retrieving Scanned Documents (Twain)
From the File menu in the application you are using, click Select . (This option may appear as ,
or Device Select Source Scanner Selection Data Source Selection In the Select Source dialog
box, select the TOSHIBA e-STUDIO GL-TWAIN Driver Click GL-10x0 Scan Operator’s Guide...

Page 57 When you are finished, click to exit the GL-TWAIN Driver and Close return to your
application. During image retrieval, the button cancels retrieving the current Close document.
GL-10x0 Scan Operator’s Guide...

Page 58: More Ways To Retrieve Documents
Start the Imaging for Windows application. From the File menu, select Open Browse for the
shared folder in the controller or network. In the controller, the folder is called GL_SHARE. Select
the file and click Open GL-10x0 Scan Operator’s Guide...

Page 59 Retrieving Using TopAccessComposer To learn how to retrieve scanned data stored
in TopAccessComposer, see the TopAccessComposer Operator’s Guide. GL-10x0 Scan
Operator’s Guide...

Page 60: Dialog Box Reference
Scanned documents are stored in folders that correspond to template groups. The screen ID for
the public template group is “000”. Folder Password: appears if the folder is password
protected. If it appears, enter the 5-digit password to access the protected folder. GL-10x0 Scan
Operator’s Guide...

Page 61 Change Folder: opens the Folder Setting dialog box, where you can select another
folder. List box: contains a list of all documents in the selected folder. Any characters that
cannot be used in filenames are replaced with an underscore (_). GL-10x0 Scan Operator’s
Guide...

Page 62 Help: opens the online Help file. Status bar: displays three types of information.
Status Area: Ready: Document retrieval can begin. Retrieving: The selected document is being
retrieved. Updating: The dialog box information is being updated (after you click Refresh
GL-10x0 Scan Operator’s Guide...

Page 63 Image Size: is the number of pixels in the image on the page. DPI: is the resolution
of the image in dots per inch. OK: returns to the Main TWAIN dialog box. HELP: opens the online
Help file. GL-10x0 Scan Operator’s Guide...

Page 64 GL-10x0 Scan Operator’s Guide...

Page 65: Monitoring Scan Jobs
. You can also cancel a scan Group Template Agent Status Time job that is waiting to be
processed. Alternatively, you can use the TopAccessDocMon utility to monitor scan jobs. See
the Operator’s Guide for details. GL-10x0 Scan Operator’s Guide...

Page 66: Managing Scan Jobs
The Scan Jobs page displays links to the various scan logs: Current Scan Jobs: lists all scan jobs
currently queued for processing Scan Jobs Log: lists completed scan jobs Scan Message Log:
lists system messages related to the scan function. GL-10x0 Scan Operator’s Guide...

Page 67 On the Current Jobs page, check the box next to the scan job that you want to delete
or click the heading to select all jobs. Check All Click Delete Click to confirm the deletion
process. The scan job(s) are deleted from the queue. GL-10x0 Scan Operator’s Guide...

Page 68 Scan Administration It is a good idea to perform regular maintenance tasks such as
resetting the scan counter, backing up and restoring the address book and scan templates, or
deleting scan files stored on the controller. GL-10x0 Scan Operator’s Guide...

Page 69: Basic Troubleshooting
This chapter provides error tables that list controller error messages and the corrective actions
you can take as an end user. It also describes GL TWAIN Driver problems and their solutions. For
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corrective actions that administrators can take, see the Administrator’s Guide. GL-10x0 Scan
Operator’s Guide...

Page 70: Error Messages
200 images if duplex). Finish scanning. Finish glass Scan (A document is on A document on the
glass is being scanned. Wait until the ADF) current scan process is complete before using the
ADF scan function. GL-10x0 Scan Operator’s Guide...

Page 71 When any job is present, either wait for the job to be completed, or delete it. If the
job does not complete, delete it. If the error persists, restart the controller. If the error still
persists after restarting the controller, contact the network administrator. GL-10x0 Scan
Operator’s Guide...

Page 72: Twain Driver Errors
The GL-TWAIN Driver dialog box may be hidden behind other windows. Minimize all other
windows. If you cannot find the dialog box, enable the Show UI feature of the GL-TWAIN driver
from the application. See the scan Readme file for more detail. GL-10x0 Scan Operator’s
Guide...

Page 73: Cannot Acquire Document
See the Readme file on the Scanner Client CD-ROM. Cannot Open a Password Protected Folder
or Document Problem Description: A folder or document is password protected and you do not
know which password to apply. GL-10x0 Scan Operator’s Guide...

Page 74 Document passwords are the same as the corresponding template password. If the
group password changes, the corresponding TWAIN folder password changes also. Document
passwords remain the same as the original template password, even if the template password
changes subsequently. GL-10x0 Scan Operator’s Guide...

Page 75: Scan Tab Reference
Download Scan Files allows you to download the scanned document files that you stored on the
controller to a local workstation. This chapter describes the fields and controls on each page of
these submenus. GL-10x0 Scan Operator’s Guide...

Page 76: Scan Jobs Page
Message Log: click this link to view scan messages. Refresh: click this link to update the scan
jobs list. Delete: click this button to cancel the selected scan jobs. A confirmation message
appears. Click to delete the jobs. GL-10x0 Scan Operator’s Guide...

Page 77: Templates Pages
You can sort the table by or by . The default sort Template Name Agent sequence is in
ascending order of , indicated by an up arrow Template Name in the column heading. To sort by
agent, click the heading. Agent GL-10x0 Scan Operator’s Guide...

Page 78 Template No.: enter a number between 1 and 60. This determines the position of the
template within the group and hence the position of the template button on the copier front
panel or Optional Large Touch Screen Monitor. GL-10x0 Scan Operator’s Guide...

Page 79 Send e-mail: optionally check one or both of these boxes to receive notification by e-
mail. The box is enabled. E-mail Address E-mail Address: enter your e-mail address (up to 90
characters). GL-10x0 Scan Operator’s Guide...

Page 80 Single Page TIFF , or (G4) MultiPage TIFF (G4) Immediately Print Scanned
Documents: Check this check box to invoke the File & Print function. The scanned document is
both sent to the specified file storage location and printed. GL-10x0 Scan Operator’s Guide...

Page 81 Subject: enter the topic of the fax (one line). Body Text: enter any cover message
(up to 1 KB). GL-10x0 Scan Operator’s Guide...

Page 82 FTP Server: enter the name or IP address of the FTP server (up to 128 characters).
FTP Server Port: enter the port number for the FTP transfer (default 21). User Name: enter the
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user name of the FTP account on the server (up to 15 characters). GL-10x0 Scan Operator’s
Guide...

Page 83: Template Groups Pages
Template Groups Pages Use these pages to create, edit, and delete template groups. To access
these pages: On the Scan tab, click the Templates submenu. By default, the main Templates
page opens. Click the link. Template Groups GL-10x0 Scan Operator’s Guide...

Page 84 You can delete multiple groups if they are not password protected. You must delete
groups with passwords one at a time. When you click this button to delete the selected group(s)
a confirmation message opens. GL-10x0 Scan Operator’s Guide...

Page 85 (up to 90 characters). Padlock symbol: optionally, check to enable Password protect
this group fields. Password Confirm Password Password: enter a password for the template (5
digits displayed as asterisks). Confirm Password: enter the same password again. GL-10x0 Scan
Operator’s Guide...

Page 86 GL-10x0 Scan Operator’s Guide...

Page 87: Glossary
Glossary Definitions of Common Terms Term Definition Auto-Document Feeder. An accessory
that allows a document to be fed or scanned without user intervention. Current jobs The list of
all print and copy jobs currently queued to the selected controller. You can view it using either
the TopAccess or the TopAccessDocMon application.

Page 88 See also Simplex. Electronic This system consists of either the TOSHIBA e-
STUDIO28/35/45 Document digital copier connected to the GL-1010 controller or the TOSHIBA e-
Processing System STUDIO550/650/810 digital copier connected to the GL-1020 controller.
These systems provide the convenience of walk-up copying, scanning, and network printing
from the same device.

Page 89 Definitions of Common Terms Term Definition Message log A file that contains a
historical record of errors and warnings that occurred on the controller or the copier. The
information for each message includes the date, subsystem, and message severity. You can
filter the message log to list only those messages that meet specific criteria.

Page 90 Definitions of Common Terms Term Definition User account The information that
TopAccessComposer stores for each registered user. This information includes a user name and
password and, optionally, a description and e-mail address. TopAccessComposer maintains a
database of all registered user accounts. WINS Windows Internet Naming Service.

Page 91: Index
61 acquire scanning 30 document 63 Administrator, maintaining scan multipage document 63
functions 58 multipage TWAIN document 63 Agents TWAIN document 63 configuring settings 18
find controller 62 scanning, using 10 Send to E-mail 18, 71 GL-10x0 Scan Operator’s Guide...

Page 92 Features, scanning 2 Document File agent editor/organizer configuring 18
introduction 3 settings 70 see TopAccessComposer Finding, document folder 47 finding the
folder 47 FTP agent retrieving 46, 48 configuring 21 applications 48 settings 72
TopAccessComposer 49 GL-10x0 Scan Operator’s Guide...

Page 93 Lightweight Directory Access Protocol using 12 see LDAP Properties defined 79
document details 48 document information 53 address, defined 78 scan agents 10 defined 78
TWAIN dialog box 52 Managing scan jobs 56 Public scan, introduction 3 GL-10x0 Scan
Operator’s Guide...

Page 94 14 file 41 private template passwords 17 finding the document folder 47 scan agents
32 folder setting dialog box 50 scan parameters 31 FTP 43 scan templates 11 iFax 42 Software,
components 2 jobs page 66 GL-10x0 Scan Operator’s Guide...

Page 95 57 public using 12 viewing 12 scan Windows Internet Naming Service settings 69
see WINS WINS template groups pages 74 defined 80 template pages 67 finding the controller
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62 using 11 TopAccess, introduction 3 GL-10x0 Scan Operator’s Guide...

This manual is also suitable for:
Gl-1010Gl-1020
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